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Introduction

Primex Wireless’s SNS analog clocks are equipped with both an 802.11 b/g and Ethernet port interface. The
clocks are able to connect in an existing wireless LAN (WLAN), supporting a wide variety of security protocols.
Once the SNS clocks are configured using the Primex Wireless Configuration Tool, settings can be altered using
Primex’s Applications Management Platform (AMP). SNS analog clocks will connect to the WLAN or Ethernet
only at the times configured with AMP or the Configuration Tool. Any changes in configuration of an SNS
analog clock via AMP are transmitted to the SNS analog clock the next time it connects to the WLAN or
Ethernet. For detailed instructions on the use of AMP, please see the Primex AMP User Manual.

SNS analog clocks can be installed anywhere indoors within range of an 802.11 b/g access point. The initial setup
procedure can be performed in a convenient central location such as a maintenance area or at the final location of
the system clock. AMP has features to determine the signal strength of the SNS analog clock’s reception.
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Precautions and regulatory compliance statements

Equipment precautions

e To avoid possible electric shock and damage to an SNS analog clock, make sure that it is unplugged when
working on it.

e SNS analog clocks are cleanable with a cloth moistened with water or a common disinfectant.
Caution Be sure to test any cleaning solutions on a small area of the clock before using it on the entire clock.

Safety precautions

SNS analog clocks are designed for indoor use only and are not weather protected. Operating the clock outdoors,
or in wet areas is an electrical hazard and may damage the clock while nullifying the warranty.

FCC compliance

Any changes or modifications not expressly approved by the party responsible for compliance could void the
user's authority to operate the equipment.

FCC radio frequency interference

This equipment has been tested and found to comply with the limits for a Class B analog device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the distance between the equipment and the receiver.

e Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

FCC radiation exposure limits

To comply with FCC RF exposure requirements in section 1.1307, a minimum separation distance of 20 cm is
required between the antenna and all persons.

Power specifications for AC-powered devices

The socket-outlet shall be installed near the equipment and shall be easily accessible

Clock model Input power Current draw

SNS7A306 100 - 240V~, 47-63Hz 67mA@120V~, 47mA@240V~
SNS7A330 100 - 240V~, 47-63Hz 134mA@120V~, 94mA@240V~

Introduction Precautions and regulatory compliance statements
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SNS analog clocks

Primex Wireless’s SNS analog clocks are equipped with both an 802.11 b/g and Ethernet port interface. The
clocks are able to connect in an existing wireless LAN (WLAN), supporting a wide variety of security protocols.
Once the SNS clocks are configured using the Primex Configuration Tool, settings can be altered using Primex’s
Applications Management Platform (AMP). SNS analog clocks connect to the WLAN only at the times
configured with the Primex AMP or Configuration Tool. Any changes in configuration of an SNS analog clock
via the Primex AMP will be transmitted to the clock the next time it connects to the WLAN. For detailed
instructions on the use of the Primex AMP, please see the Primex AMP User Manual.

Primex Wireless SNS analog clocks can be installed anywhere indoors within range of an 802.11 b/g Access
Point. The initial setup procedure detailed below can be performed in a convenient central location such as a
maintenance area or at the final location of the system clock. Primex’s Applications Management Platform has
features to determine the signal strength of the clock’s reception.

Primex Wireless SNS analog clocks are available in a variety of sizes and finishes to complement the décor of
your facility. All SNS analog clocks feature:

o The battery life of SNS analog clocks is up to seven years with Primex Wireless #SNS887 lithium DD-cell
batteries (up to four years with high-quality alkaline D-cell batteries). AC-powered models are also available

e Operating range: 32° - 158°F (0° - 70°C)

e A school mascot. A company logo. A city's colors. Now, you can show your pride with custom logo clocks.
Available on all Primex Wireless clocks for an additional fee.

Model number  Description Color Power source  Weight  Mounting
SNS4Z155 12.5" Traditional series Black Batteries 1.7lb Clock Lock (2)
SNS4Z157 12.5" Traditional series Toupe Batteries 1.7lb Clock Lock (2)
SNS4Z7159 12.5" Traditional series White Batteries 1.7Ib Clock Lock (2)
SNS7A306 12.5" AC Black 100-240v~ 2.0lb Clock Lock (2)
SNS4Z164 12.5" Dual sided wall Black Batteries 6.0lb Twist Lock
SNS7A330 12.5" Dual sided AC wall Black 100-240v~ 6.6lb Twist Lock
SNS47163 16" Traditional series Black Batteries 2.4lb Clock Lock (2)
SNS42176 16" Wood Oak Batteries 3.4lb Clock Lock (1)
SNS4z177 16" Wood Cherry Batteries 4.91b Clock Lock (1)
SNS47512 13.75" Platinum series Silver Batteries 1.6lb Clock Lock (2)
SNS4Z180 12.5" Brushed aluminum Aluminum | Batteries 2.4lb Clock Lock (2)
SNS4z227 15" Dual brushed aluminum Aluminum | Batteries 5.2Ib Fixed mount
Precautions and regulatory compliance statements SNS analog clocks




Page 4 SNS Analog Clocks User Manual

Traditional series

With simple dials and durable polycarbonate frames and lenses, these clocks are
designed for easy viewing. The patent-pending Clock Lock™ feature prevents
employees from removing clocks from walls, and high-impact polycarbonate frame
and shatterproof lens provide added safety. Dual-sided clocks are well-suited for
hallway use. A variety of styles, colors and sizes lets you coordinate with your
facility’s décor.

Metal series

Contemporary brushed aluminum frames offer an upscale, executive look to our high-
performance clocks, a smart choice for offices and reception areas. These high-tech,
synchronized clocks are easy to install, immediately keeping time with the rest of the
Primex Wireless Clock System.

Platinum series

The Platinum Series is the first and only analog clock series available with a high impact
frame with chemical resistant coating and Xylex lens to protect against commonly used
cleaners and dust collection. The smart design provides a clean look that can easily be
incorporated into a variety of settings ranging from the science lab, to food preparation areas,
or even individual classrooms.

Wood series

Solid 16” hardwood frames of cherry or oak with glass crystal lens are handsome timekeepers
for school offices, libraries and entryways.

SNS analog clocks Precautions and regulatory compliance statements
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Configure an SNS analog clock

Follow these steps to configure an SNS analog clock.

1. In order to configure an SNS analog clock, you must connect directly the SNS clock to the computer with a
network cable. If you’re using a laptop computer or a desktop computer with a wireless network card, you
must disable the wireless network card in order to facilitate communication with the SNS analog clock.
Follow these steps to prepare your computer to communicate with SNS analog clocks.

A. Choose Start » Settings » Control
Panel » Network Connections.
Windows displays a Network
Connections window containing
LAN or High-Speed Internet
information similar to that shown
here.

B. If your computer has a wireless
network card, right-click the
Wireless Network Connection
item and choose Disable on the
context menu displayed.

C. Right-click the Local Area
Connection item and choose
Properties on the context menu
displayed. Windows displays a Local
Area Connection Properties
dialog box similar to the one shown
below.

ame

| Type Status Device Ma

LAN or High-Speed Internet
<L 1394 Connection LAM ar High-Speed Inter,,.  Connected 1394 Net: |
<L local Area Connection Lan o High-Speed Inter...  Mebwork cable unplugged EBroadcom
LAkl o Hinh.Socad Tokar ot connected Dell wirele

Disable
¥iew Available Wireless Networks
Stakus
Repair

Eridge Connections

Create Shortcut
Delete
Rename

Propetties

Marme | Type | Skatus | Device Mal
LAN or High-Speed Internet
<L 1394 Connection LAM ar High-Speed Inter,,.  Connected 1394 Net
Local Area Connectiol : a0 ot High-Speed Inter,..  Metwork cable unplugged Broadcom
U ywireless Mebwark Car Eisiue ot High-Speed Inter.,, Mok connected Ll wirelg]
atus
Repair
Bridge Connections
Create Shorkout
Delete
Rename
-4 Local Area Connection Properties HE

D. On the General tab, select the Internet Protocol
(TCP/IP) item in the This connection uses the

following items list then click the Properties

button. Windows displays an Internet Protocol
(TCP/IP) Properties dialog box similar to the one

shown below.

General I Advanced I

Connect using:

I B8 Broadcom Netxtreme 57xx Gigabit C Canfigure... |

Thiz connection uzes the following items:

% Cliert for Microsoft Metworks

.@ File and Printer Sharing for Microzoft Netwarks
.@ (05 Packet 5 cheduler

5 Internet Pratocol [TCR/IP)

Install... I Wrirstall Froperties

— Description
Transmission Control Protocol/Intermet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

[~ Show icon in notification area when connected
V' Natify me when this connection has limited or no connectivity

Ok | Cancel I

Configure an SNS analog clock

SNS analog clocks



Page 6 SNS Analog Clocks User Manual

E. Choose the Use the following IP address option Internet Protocol (TCP/IP) Properties (7] %]
button. General I
F_ Enter 1 921 681 1 00 il'l the IP address ﬁeld You can get IP setting: assigned automatically if pour netwark suppoarts

thiz capability. Otherwise, you need to ask your network. administrator for
the appropriate [P settings.

G. Enter 255.255.255.0 in the Subnet Mask field.

H. Click the OK button to accept the changes you’ve & Use the following IP address:
made, close the Internet Protocol (TCP/IP) P address T e 1 1m0

£ Obtain an [P address automatically

Propertle's dialog box. and return to the Local Area < ybret mask =
Connection Properties dialog box. 5 _
Default gateway: I . . .

I.  Click the OK button to accept the changes you’ve
made’ CIOSC the Local Area ConneCtion — Use the following DMS server addresses—————————————————
Properties dialog box and return to the Network Profared DNS scrver T

Connections window. ,
Alternate DMS server I . . .
J. Close the Network Connections window.
Advanced... |

oK I Cancel |

= [htair DS senven addiess autamatcall

2. If the clock is mounted on a wall, dismount the
clock from the wall so that you can access the
back of the clock.

3. Physically connect the SNS analog clock directly
to the PC or laptop using a standard network
cable. The SNS analog clock has an RJ-45
network cable jack on its back.

PC or Laptop

SNS analog clocks Configure an SNS analog clock
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4. Ifthe clock you’re configuring is battery powered,
remove the batteries. If the clock you’re
configuring is AC-powered, unplug the clock.

5. If'the clock you’re configuring is battery powered,
insert the batteries in the clock while holding
down the button on the back of the clock. Release

the button after completing battery installation. Clock Movement —s «-—Eg':?rnet

After approximately two seconds, the clock beeps

once to indicate that it’s ready to configure. Bution

Clock Lock

6. Ifthe clock you’re configuring is AC-powered,
plug the clock into the AC power outlet while
holding down the button on the back of the clock.
Release the button after plugging the clock in.
After approximately two seconds, the clock beeps
once to indicate that it’s ready to configure.

Button
Ethernet Port

Clock Movement

AC Power Supply

AC Power Cable

Strain Relief Clock Lock

7 AC Power Plug

7. Choose Start » Programs » Primex Wireless » Primex Wireless Configuration
tool or double-click the Primex Wireless Configuration Tool icon on your computer’s
desktop.

Configure an SNS analog clock SNS analog clocks
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8. Windows displays a Primex Wireless Configuration Tool window similar to the one shown here.

B‘_‘EPrimeu Wireless SNS Configuration Tool

File  Edit  Actions  Help

ol dadliotlg saloalsd e Bdn |

Clock Configuration | Commurication Log | Time Zones |

Clock Marme: I

Time Zaone: I[GMT-EIE:EIEI] Central Time (IS, Canada)
GMT Offzet: I-DE:EIEI [T Use Daylight Saving Time

[

A .-;-‘:1dress AMP Gateways
Hardware: IP Address 10 P [1600
Clack:
IP Add & Part: I‘I E00
o, ress : orl
IP Address 2 Part: I'I G000
— wired Metwork Setting
— MTP Servers — Daily Svnc Timez [2dhr mode) [T UseDHCP
Address 1: I Time: |E|2;|:||:| Time: I P Address: I
Address 2: I Time: I Time: I Subnet Maszk: I
Address 3 I Tirne: I Tirne: I G atenaay: I
— wireless Metwark Setting 1 — wireless Metwork Sething 2 ———— — wireless Metwark Setting 3
551D: | 551D: | 551D: |
™ Use DHCP ™ UseDHCP ™ UseDHCP
IP &ddress: I IP Address: I IP Address: I
Subnhet Mazk: I Subnet Mazk: I Subnet bazk: I
(3 ateway: I GEateway: I (3 ateway: I
Secunty Type: I'w'EF' j Security Tope: IWP,&. ﬂ Secunty Type: I'w'F'ﬂ.2 j
Securty Mode:  Shared € Open Security Mode: {8 AFS & TKIP Secuity Mode: & AES  TEIP
Securty Fey: I Security Few I Secunby Key: I
[T Use RADIUS - LEAP [T Use RADIUS - LEAP [T Use RADIUS - LEAP
zemame: I lzername: I zemame: I
FPazzword: I Pazzwaord: I FPazzword: I

Mot Connected

9. Click the Connect button on the toolbar or choose the Actions » Connect menu item to establish o
a connection to the clock. The clock should report its Media Access Control (MAC) Address and L =
hardware/clock/radio version numbers and those settings will be displayed in the upper left corner
of the Configuration tab. The status bar at the bottom of the window displays either a Connected! or
Connection Failed! message depending on whether a connection to the clock succeeded or failed.

Note Once a connection with the clock has been established, the other Action menu commands and toolbar
buttons are enabled and no longer grayed out.

SNS analog clocks Configure an SNS analog clock
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10. Click the Read Configuration from Clock toolbar button or choose the Actions » Read T
Configuration menu item. The status bar at the bottom of the window displays a Configuration a‘_:f'
read from device! message and the fields on the Configuration tab are updated with the
configuration values read from the clock.

Note SNS analog clocks have a password that prevents their configuration settings from being read unless the
clock is first logged into. If the clock is configured with a different password than the password currently
stored in the Configuration Tool the login will fail and you will receive the alert message and the status
bar displays the message Read Failed! The password is stored in the Configuration Tool’s
Preferences settings and can be changed by using the Edit Preferences command.

11. Fill in the fields with the desired configuration settings. The following fields are available for you to fill in to
configure the clock:

Note Invalid values are indicated with red text in the field. When you exit a field in which an invalid value has
been entered, you may also hear a beep from the system if your laptop or PC supports it.

Setting Required Valid values

name

Clock 1 to 40 characters. A recommended practice is to name a clock to reflect where the
Name clock is (or will be) physically located.
Time Zone | N Select from the list of available time zones. If a selection is made, the GMT Offset

field will be set based on the time zone selected. This selection also determines the
DST Transition Dates downloaded to the clock if the clock is configured to use DST.

GMT Offset | Y -14:00 to +14:00, the offset from Greenwich Mean Time (GMT) that the clock should
display. The format is hh:mm and the field text will turn red if it contains an invalid
value.

Use Y Yes/No checkbox set to indicate whether the clock should adjust its time for Daylight

Daylight Saving Time.

Saving

Time

MAC N/A The read-only MAC Address field is populated with the MAC address of the clock

Address currently connected to the configuration tool.

Hardware N/A The read-only Hardware field is populated with the hardware version of the clock

currently connected to the configuration tool.

Clock N/A The read-only Clock field is populated with the clock firmware version of the clock
currently connected to the configuration tool.

Radio N/A The read-only Radio field is populated with the radio firmware version of the clock
currently connected to the configuration tool.

You may enter the IP address and port for up to three AMP Gateways. The clock
will attempt to connect to them in the order listed when trying to report its current
condition at each time synchronization. You must enter settings for at least one
AMP Gateway.

AMP Gateway

IP address Y, for each AMP The IP address must be a valid IPv4 address. The value will be converted to
(1-3) Gateway standard notation if an abbreviated form is entered. The field text will turn red if it
contains an invalid value.

Port (1-3) Y, for each AMP | The port to connect to on the AMP Gateway must be a valid port number from 0 to
Gateway 65535. The field text will turn red if it contains an invalid value. The default port is
usually 1600.

Configure an SNS analog clock SNS analog clocks
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Setting

name

NTP Servers

IP address
(1-3)

Daily Sync
Times (1-6)

Required

Y, for each NTP
Server

Daily Sync Times

At least 1

Wired Network Setting

Valid values

You may enter the IP Address for up to three NTP servers. The clock attempts to
connect to all configured NTP servers when synchronizing time and uses the first
NTP server to respond.

Note If no NTP Server IP addresses are entered, the clock will not be able to
synchronize time.

The IP Address field may accept a valid IPv4 address or may DNS Names for NTP
servers. Some examples are:

e time.microsoft.com
e time.nist.gov
e 0.us.pool.ntp.org

You are required to specify at least one and up to six times during the day that the
clock should attempt to synchronize with the configured NTP Servers.

The time of day that the clock should synchronize must be entered in 24 hour mode,
using a format of hh:mm. The field text will turn red if it contains an invalid value. If
the same value is entered more than once, the repeated entry is ignored. You do
not have to enter the colon (:) character, and/or may use a decimal (.) character to
separate the hour and minute values.

You have the option to enter information for a wired network configurations.

Use DHCP | Y Yes/No checkbox set to indicate whether the clock should request a dynamically
assigned IP Address network each time it connects to the wired network.

IP Address | Y The static IP address for the clock to use when connecting to the network. The IP
address must be a valid IPv4 address. The field text will turn red if it contains an
invalid value.

Subnet Y The subnet mask must be a valid IPv4 address mask. The field text will turn red if it

Mask contains an invalid value.

Gateway Y The network gateway IP address must be a valid IPv4 address. The field text will

turn red if it contains an invalid value.

SNS analog clocks

Configure an SNS analog clock
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Setting

name

Required

Valid values

Wirel Network Setti You have the option to enter information for up to three wireless network settings.
Ireless Network Setlings The clock attempts to connect to all configured network settings when synchronizing
time and uses the first network setting to respond.
Note  If no network settings are entered, the clock will not be able to connect to
the network to synchronize time or report its condition.
Y, for each Service Set Identifier (SSID) 0 to 40 characters. The SSID for the wireless network.
wireless network
setting
Use DHCP | Y, for each Yes/No checkbox set to indicate whether the clock should request a dynamically
wireless network. | assigned IP address network each time it connects to the wireless network.
setting
IP Address | Y, for each The static IP address for the clock to use when connecting to the network. The IP
wireless network | address must be a valid IPv4 address. The field text will turn red if it contains an
setting invalid value.
Subnet Y, for each The subnet mask must be a valid IPv4 address mask. The field text will turn red if it
Mask wireless network | contains an invalid value.
setting
Gateway Y, for each The network gateway IP address must be a valid IPv4 address. The field text will
wireless network | turn red if it contains an invalid value.
setting
Security Y, for each Select from the available security types; you may choose from:
Type wireless network | ¢  None
setting e WEP
e WPA
o WPA2
Security Y, for each Not required if Security Type is set to None. If Security Type is set to WEP, select
Mode wireless network | from the available security modes; you may choose from:
setting e Shared
e Open
If Security Type is set to WPA or WPA2, select from the available security modes;
you may choose from:
e AES
e TKIP
Security N if security 0 to 64 alphanumeric characters.
Key mode is set to
None
Use N Enable (check) the Use RADIUS — LEAP checkbox if your network administrator
RADIUS - requires the RADIUS — LEAP authentication protocol on your network.
LEAP
Username Required if the Use RADIUS — LEAP checkbox is checked; 0 to 10 alphanumeric
characters.
Password Required if the Use RADIUS — LEAP checkbox is checked; 0 to 64
alphanumeric characters.
12. Click the Write Configuration to Clock toolbar button or choose the Actions » Write =
Configuration menu item. -._..,.-‘Il

Configure an SNS analog clock
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Install an SNS analog clock

The backs of most SNS analog clocks feature two specially designed Clock-Lock hangers spaced at precise
distances, one on the top, and the other on the bottom. The Clock-Lock feature prevents accidental removal if
the clock is bumped and it may reduce theft by requiring a particular combination of moves to remove the clock.
All SNS analog clocks come with two #6 x 1-1/4” mounting screws and wall anchors. When hanging the clock,
be sure that if two screws are being used to secure the clock to the wall, that the distance between the screws be
precisely the same as that in the table below.

Note To avoid the Clock-Lock feature, use finishing nails with no heads angled at 45 degrees into the wall in
place of headed screws or nails. The clock may then be mounted and removed like a standard clock.

Model number  Description Hole spacing Mounting type
SNS4z155 12.5" Traditional series 9’ 1.7Ib Clock Lock (2)
SNS4z157 12.5" Traditional series 9” 1.7Ib Clock Lock (2)
SNS4z159 12.5" Traditional series 9 1.7Ib Clock Lock (2)
SNS7A306 12.5" AC-powered 9” 2.0lb Clock Lock (2)
SNS47164 12.5" Dual-sided See instructions 6.0lb Twist Lock
SNS7A330 12.5" Dual-sided AC-powered See instructions 6.6lb Twist Lock
SNS47163 16" Traditional series 9” 2.4lb Clock Lock (2)
SNS4Z7176 16" Wood 9" 3.4lb Clock Lock (1)
SNS4z177 16" Wood 9" 4.91b Clock Lock (1)
SNS47512 13.75" Platinum series 9” 1.6lb Clock Lock (2)
SNS4z180 12.5" Brushed aluminum 9’ 2.4lb Clock Lock (2)
SNS4z227 15" Dual-sided brushed aluminum See instructions 5.2Ib Fixed mount

Install a single-sided analog clock

Follow these steps to install a single-sided clock:

1. Drill holes for the screw anchors at the spacing
listed in the table above.

2. Use a screwdriver to insert and tighten the screw, |_ 0 clocktock
leaving the top of the screw head 3/8” out from =
the wall. 9.0 inches

3. Hold the clock with the face down and align the L v Siide lock down
Clock Lock hanger with the bottom screw. Screw spacing Align hanger with screw

4. Tilt the clock face to vertical and position the clock with the screw heads in the opening of the Clock Lock
hanger.

5. Slide the clock down over the screw heads to latch it into place.

SNS analog clocks Install an SNS analog clock
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Install a SNS4Z164 or SNS7A330 dual-sided clock

Follow these steps to install a SNS4Z164 or SNS7A330 dual-sided clock:

Notes SNS4Z164 or SNS7A330 dual-sided clocks 5“50'; (13.9/cm)
come with self-tapping screw anchors (for 4.50" (11.43cm)

drywall installation) and mounting screws. F2.25" (5.72cm)
) Center Screw Hole
Complete the Configure an SNS analog / <

clock and Install batteries in an SNS . O

analoq clock procedures before mounting an

SNS4Z164 or SNS7A330 dual-sided clock. IB [ﬂl 305"
{(8.26cm)

1. Ifyou’re installing the clock on a drywall surface,
install the screw anchors at the spacing shown

here.
7.50"

2. Install the mounting plate with the screws (1 9.105cm)

provided.
6.50"
l@ @l {16.517cm)

3. Slide the bracket attached to the assembled dual
sided clock over the mounting tabs onto the
mounting plate as shown here. A gentle tap with a
rubber mallet may be needed for this step, as it is
a tight fit.

4. [Install the provided short screw through the top
center hole on the bracket. This will increase the
security of the clock assembly.

Install an SNS analog clock SNS analog clocks
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Install a SNS4Z227dual-sided clock

Follow these steps to install a SNS47227 dual-sided clock:

Note SNS4Z227 dual-sided clocks come with self-tapping screw anchors (for drywall installation) and
mounting screws.

1. The supplied hardware pack contains a mounting plate, four long screws, and four wall anchors. Secure the
mounting plate to the wall or ceiling with the four long screws, paying attention to the “up” arrow, at the
location you will be hanging the clock.

2. Remove one clock from the bracket by removing two of the four factory-installed screws. With the dual clock
flat on a soft surface to protect the lens and bezel, remove the two top screws and lift the top clock off of the
dual mounting bracket. (Note: It may require some force to remove the top clock because, in addition to the
screws, the clocks are also held in place by magnets.)

Set each clock using method detailed on the setup instruction sticker on the back of each clock.

Once the clocks are set (with batteries inserted), orient the clock face so that the 12 is in the correct position
for your mounting option. (Note: clocks are shipped in correct position for wall mounting. If ceiling mount is
required, both clocks must be removed and rotated within the bracket.)

5. Align one of the posts on the back of the clock with the appropriate post in the bracket, next to a clip. Make
sure that the raised portion of the clip next to the post is inside the bracket.

6. Lower clock down on bracket, keeping all clips inside ring. Press down to seat clock in bracket. Secure with
the two screws removed previously, in same holes in bracket (over screws holding other clock in place).

7. Four additional screws are included in package to cosmetically plug holes in bracket, if desired.
Check to make sure that the 12 o’clock position is oriented to read correctly from both sides of the clock.

Taking the fully assembled dual clock, line up the base (stem) of the clock with the plate that is mounted on
the wall. Slip the keyhole slots on the back of the base over the posts on the plate and push the clock down to
secure.

SNS analog clocks Install an SNS analog clock
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Install batteries in an SNS analog clock

Note The battery life of SNS analog clocks is up to seven years with Primex Wireless #SNS887 lithium DD-
cell batteries or up to four years with high-quality alkaline D-cell batteries. Therefore, it is important that
fresh, superior-quality batteries, with an expiration date that exceeds five years past the installation date,
be used for the clock.

The SNS analog clock notifies the user when the batteries need to be changed by moving the second hand in five-
second increments instead of one second at a time. Battery condition is also reported via AMP. The clock will
retain its configuration after the batteries are replaced.

e Use only new high-quality name brand alkaline batteries
e Batteries should be the same type and date code

e The use of heavy duty and zinc carbon batteries is not recommended, as they will not last as long as high-
quality name brand alkaline batteries

e Do not use rechargeable NiCad batteries, as their output voltage is too low to assure proper operation
e Do not use standard lithium batteries
Follow these steps to replace the batteries in an SNS analog clock:

1. Dismount the clock from the wall so that you can
access the back of the clock.

Remove the old batteries, wait 10 seconds.

Insert two new Primex Wireless #SNS887 DD-
cell batteries or four new alkaline D-cell batteries.

4. When the batteries are in place, the SNS analog Clock Movement —» «n—gth’?rnet
0l

clock will execute the initialization process and
set the hands to the correct time. Button

Install batteries in an SNS analog clock SNS analog clocks
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Remove an Clock Lock-mounted SNS analog clock

Follow these illustrated steps to remove an SNS analog clock

While applying

Apply counter- the counter- Then apply
clockwise clockwise clockwise
turning force force, lift clock turning force

3/4" to stop

STEP 1
While applying While still applying
the clockwise force, the clockwise force,
lower clock 1/4" lift clock off mounting screws

SNS analog clocks Remove an Clock Lock-mounted SNS analog clock
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Configuration tool procedures

Remove an Clock Lock-mounted SNS analog clock Configuration tool procedures
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Set the password for a clock

Each clock contains a password which must be used to login to the clock before any of the configuration settings
can be read from the clock. The password used by the Configuration Tool is stored in the tool’s Preferences
settings and can be changed by using the Edit Preferences command (see the Preferences section of this manual).
To write the Primex Wireless Configuration Tool ‘s current password to a clock the tool has established a
connection with, you can use the Set Device Password toolbar button or the Actions > Set Device Password menu
command.

1. Click on either the Set Device Password toolbar button or the Actions > Set Device Password menu command,
both of which should be enabled once a connection to the clock has been established.

2. The status bar at the bottom of the window should display a “Device Password Set!” message.

Configuration tool procedures Set the password for a clock



SNS Analog Clocks User Manual Page 19

Disconnect an SNS analog clock

To disconnect a clock from the Primex Wireless Configuration Tool, the following steps should be performed:

1. Click on either the Disconnect toolbar button or the Actions > Disconnect menu command, both of which
should be enabled once a connection to the clock has been established.

2. The status bar at the bottom of the window should display a “Disconnected” message.

3. Physically disconnect the clock from the PC or laptop by disconnecting the network cable that was used to
connect the devices.

4. The clock should restart and attempt to connect to the network using any configuration settings that were
written to it and perform a time synchronization.

Note You can physically disconnect the clock from the PC or laptop, without first using the Disconnect
command, however if you do so, note that the Primex Wireless Configuration Tool may not realize the clock has
been disconnected until you try to issue another command to the clock.

Disconnect an SNS analog clock Configuration tool procedures
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Upgrade the firmware for an SNS analog clock

The Primex Wireless Configuration Tool can be used to download new firmware to an SNS analog clock if the
proper firmware files are available. SNS Firmware files typically have a .rom extension, and you should only
attempt to upgrade an SNS analog clock with an authorized Primex Wireless firmware file or you risk rendering
your clock completely inoperable. Once a connection has been established from the Primex Wireless
Configuration Tool to the SNS Clock (see Connecting the Clock) you can initiate a firmware upgrade of the clock
by performing the following steps:

1. Click on either the Upgrade Firmware toolbar button or the Actions > Upgrade Firmware... menu command,
both of which should be enabled once a connection to the clock has been established.

2. An Open dialog window will be displayed to allow you to specify the Primex Wireless Firmware file that
should be used to upgrade the clock. By default, the Open dialog is set to look for files with a .rom file extension.

3. Double-click the desired Firmware file or select the file and click the Open button.

4. The status bar will display a “Waiting for device to download Firmware Upgrade file!” message while the
clock begins pulling down the file.

Note Do not disconnect or power down the clock during the download process, which may take up to six (6)
minutes.

5. Once the SNS Clock has completed pulling down the Firmware Upgrade file, the status bar will display a
“Firmware download complete!”” message and the clock should go through a restart cycle and may be
disconnected from the laptop or PC.

Configuration tool procedures Upgrade the firmware for an SNS analog clock
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Configuration Templates

Save a configuration template file

A significant portion of the information you configure your SNS Clocks with will be they same for all or a
significant number of your clocks since they will be accessing your same network or Virtual LAN. To facilitate
this, once you have entered the information for one of your clocks in the Primex Wireless Configuration Tool you
can save that information in a template file for reuse at a later time. All the information entered is stored in the file
with the exception of the Clock Name, which you would typically want to be unique for each clock. To save the
clock information in a template file, all the information fields must contain valid values, and then the following
steps should be performed:

1. Click on either the Save File or Save File As toolbar button or the File > Save... or File > Save File As.. menu
commands.

2. You will not be able to save the configuration settings to a template file if any of the fields contain invalid
values (indicated with red text). Attempting to do so will generate the following error dialog: Correct the invalid
value and try again.

3. If you selected the Save File command on a set of configuration settings you previously read from a file, the
data will be saved back to that file. If the data was entered into a “New” form, or the Save File As command was
selected, a Save As dialog window will be displayed to allow you to select where the file should be saved. By
default, Primex Wireless SNS Configuration files are saved with a .pwc file extension, but you

can use whatever name and extension you prefer.

Open a configuration template file

To open a previously saved Primex Wireless SNS Configuration file the following steps should be performed:
1. Click on either the Open File toolbar button or the File > Open... menu command.

2. If you have changed any data in the current configuration setting values displayed on the configuration tab you
will be prompted if you want to save those configuration values before opening the new set of configuration
values. If you select Yes, and those configuration settings were previously read from a file, the data will be saved
back to that file. If the data was entered into a “New” forma Save As dialog window will be displayed to allow
you to select where the file should be saved.

3. An Open dialog window will be displayed to allow you to specify the Primex Wireless SNS Configuration file
that should be opened.

By default, Primex Wireless SNS Configuration files are saved with a .pwc file extension, but you can change the
Files of type setting in the window to display files with other extensions, if you elected to save your configuration
files with a different extension.

4. You can either double-click the file once you have found it, or select the file and click the Open button. The
configuration information stored in the file will be loaded into the Configuration tab.

5. If the file you selected is not a valid Primex Wireless SNS Configuration file, one of the following error
messages will be displayed and the fields of the Configuration Tab will not be updated:

Configuration Templates Configuration tool procedures
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Ping a clock

The Primex Wireless Configuration Tool provides the ability to ‘ping’ the clocks it is connected to. To do so,
select the Ping Device command from the toolbar or the Communications Log context menu.

Configuration tool procedures Ping a clock
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Display network information

You can also display the network settings in use by your laptop or PC while connected to the clock by selecting
the Show Network Info command from the toolbar or the Communications Log context menu. This can be helpful
in making sure the clock is allocating your machine a valid IP Address when it is connected directly to the device.

Display network information Configuration tool procedures
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Communication log procedures

While active, the Configuration Tool keeps a log of all the communication sent and received between itself and
the devices it establishes a connection with. The log is cleared each time you exit the application and a fresh log is
started each time the application is started. You can view the current log at any time by clicking the
Communication Log tab.

If an error occurred, it is displayed in the Communications Log to help determine exactly what happened.

Clear the communication log

You can clear the Communications Log at any time by right-clicking in the display of the Communications Log
and selecting the Clear Log command from the context menu.

After selecting the Clear Log command, you will be prompted if you are sure you want to clear all the data from
the Communications Log before the log is actually cleared.

Copy the communication log

You can select and copy portions of the Communication Log by selecting the text and using the standard copy
command. You can also easily copy the entire contents of the Communication Log to the clipboard so it can be
pasted into a document or email message by selecting the Copy Entire Log command from the toolbar or the
Communication Log context menu. The contents will be copied as rich text, so if you paste it into a Microsoft
Word document it will retain any color coding.

Save the communication log

You can easily save the entire contents of the Communication Log to a file, as rich text, by selecting the Save Log
command from the toolbar or the Communication Log context menu. This will open a Save As dialog window
allowing you to specify where to save the file and the filename to use. By default, a filename of

“Primex WirelessConfigLog.rtf” will be used, but you can change this.

Print the communication log

You can Print the entire contents of the Communication Log by selecting the Print Log command from the toolbar
or the Communication Log context menu. This will open the standard Print dialog window allowing you to select
the printer and options to use. You can also use the File > Page Setup... and File > Print Preview... menu
commands while displaying the Communication Log tab to configure and preview what the printout will look like
before sending it to the printer.

Configuration tool procedures Communication log procedures
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Time zone information

Time Zone options and the Daylight Saving Time (DST) transition dates for each time zone are kept in a data file
which is part of the installation of the Primex Wireless Configuration Tool. The Time Zone tab can be used view
what time zones are available and what DST transition dates stored for each time zone, if any. Each Time Zone
entry in the display can be expanded or contracted by clicking on the plus (+) or minus (-) character displayed
before the entry.

Time zone information Configuration tool procedures
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Set preferences

The Configuration Tool allows you to adjust several
settings which affect how the application behaves
for your installation of the application. These
settings can be altered and the changes written to
disk so your preferred behavior for the application
will be remembered the next time you use the
Configuration Tool.

To view and edit the Preference Settings » ]
for the Primex Wireless Configuration j-.‘_
Tool, click the Edit Preferences toolbar
button or choose the Edit » Preferences... menu
item. The Configuration Tool displays a
Preference Settings dialog box similar to the
one shown here.

Preference Settings

El Misc
DevicelPaddress
D evicePassword
DevicePort
LogBackgroundColor
LagD ataCalar
LagFailCalor
LaglabelCalor
LogPassCalar
LagRcvdCalor
LagSentColor
LogT itleColar
Lag'w'ordw/rap
FesponseTimeout_mSec
UpgradePort
WindowR esizable

192.168.1.1
adminl 234
1600

Il Black
B Green
B Red
I Gray
1 LimeGreen
Bl Blue
[] Gold
Bl Blue
True
20000
5050
False

Clicking on a color setting will display a drop-down which allows you to select a color value. Clicking on a
True/False setting will display a drop-down allowing you to pick either a True or False value.

Device address

By default, clocks in configuration mode act as DHCP servers to allocate I[P Addresses to devices connected to
them and the devices use an [P Address of 192.168.1.1. The Primex Wireless Configuration Tool is configured to
attempt to connect to IP address 192.168.1.1 on port 1600 when attempting to connect to a clock.

Device password

The device password is used by the Primex Wireless Configuration Tool to log in to clocks in order to read their
current settings. You can change this password from the default and set it in all of your devices using the Set
Device Password command if you wish to use a custom password in all of your clocks.

Device port

Communication log settings

The Primex Wireless Configuration Tool uses color coding when displaying messages in the Communication
Log. These settings allow you to adjust those color settings to your own personal tastes.

Log background color

Log data color

Log fail color

Configuration tool procedures

Set preferences
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Log label color

Log pass color

Log rcvd color

Log sent color

Log title color

Log word wrap

Response timeout mSec

Upgrade port

When performing a firmware update on a clock, the device pulls the information from the Configuration Tool.
This setting specifies what port the device should attempt to connect to the Configuration Tool application on in
order to pull the firmware upgrade file down. The default value of 5050 for this port should work fine in most
cases, but can be changed to another port if your laptop or PC already has an application using port 5050.

Window resizable

By default, the Configuration Tool runs in a fixed size window. You can change this setting to allow the window
to be resizable. This can be advantageous when viewing the Communication Log tab, but the forms displayed by
the Configuration Tool will not resize and will simply be displayed in the upper left of the tab. Note that there is a
fixed minimum size set to make sure the entire form remains visible when being displayed.

Set preferences Configuration tool procedures
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Troubleshoot

Problem:
You receive a File not Found error on startup.
Solution:

The Time Zone and Daylight Saving Time Transition Date data is kept in an XML data file which must be located
in the same directory as the Configuration Tool executable. This is done at installation time, but if you copy just
the ‘.exe’ file to another folder and try to run the file from there you may get this error message. To prevent this,
run the executable from the directory it was originally installed in, or make sure you copy the TimeZones.xml
file with the PW Config Tool.exe file.

Configuration tool procedures Troubleshoot
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Appendix — Install/remove Configuration tool software

This appendix describes the minimum system requirements for the Primex Wireless Configuration Tool software
and how to install it.

¢ Minimum system requirements

o Install Configuration Tool software

Troubleshoot Appendix — Install/remove Configuration tool software
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Minimum system requirements

e Operating System

e Supporting Software
e Disk Space Required
e Network

e Network Cable

¢ Minimum Screen Resolution

Windows XP, Windows 2000, Windows 2003, Windows Vista
Microsoft .NET Framework version 2.0 or later

10 MB

Network Interface Card with RJ-45 jack

1 Cat 5 wired straight through with RJ- 45 connectors

1024 x 768

Appendix — Install/remove Configuration tool software Minimum system requirements
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Install Configuration Tool software

Follow these steps to install the Primex Wireless
Configuration Tool software:

1.

Note

Insert the Primex Wireless Configuration Tool software
CD. Windows automatically launches the setup wizard
and displays a Welcome to the Primex Wireless
Configuration Tool Setup Wizard dialog box similar
to the one shown here.

If Windows does not automatically launch the setup
wizard, browse to your CD drive and double-click
setup.exe to launch the setup wizard.

2. Click the Next> button. The wizard displays a Select

Installation Folder dialog box similar to the one
shown here. The wizard shows the default installation
path (C:\Program Files\Primex Wireless\Primex
Wireless Configuration Tool) in the Folder field.

You may determine the impact of installing the
configuration tool on your computer by clicking the Disk
Cost button. The wizard displays a Primex Wireless
Configuration Tool Disk Space dialog box similar to
the one shown here. The Primex Wireless
Configuration Tool Disk Space dialog box shows all
available drives on your computer with their disk size,
free space available, amount of space required to install
the configuration tool and amount of space remaining
after installation of the configuration tool.

Welcome to the Primex Wireless Configuration
Tool Setup Wizard

The installer will guide vou through the steps required to install Primes Wireless Configuration Tool an
Vour computer.

WARNING: This computer program is protected by copyright law and international breaties.
Unauthorized duplication or distribution of this program. or any portion of it may result in severe civil
of criminal penalties, and will be prosecuted to the marimum extent possible under the law,

Cancel | < Back

i'é" Primex Wireless Configuration Tool

Select Installation Folder

The installer will install Primex Wireless Configuration Toaol to the follawing folder.

Toinstall in this folder, click "Mext". To install to a different folder, enter it below or click “Browse

Folder:

C:\Program FileshPrimes Wirsless\Primes Wireless Configuration Toal’ Browse..

Disk Cost.

Install Primex Wireless Configuration T ool for pourself, of for anyone who uses this computer:

" Everone

i Just me

Cancel | < Back | Next > I
i!:_?: Primex Wireless Configuration Tool Disk Space m

The list below includes the drives you can install PrimexWireless Configuration Tool to, along with
each drive's available and required disk space.

“olume Disk Size Awailable Fequired Difference
Ele 1M1GE 47GB 1437KB 47GE

Install Configuration Tool software
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4. Ifyou’d prefer to install the configuration tool to a

different location, click the Browse button. The wizard
displays a Browse for Folder dialog box similar to the
one shown here. Use the Browse for Folder dialog box
to choose a new location in which to install the
configuration tool. Click the OK button when you’ve
chosen your preferred location to accept your changes
and return to the Select Installation Folder dialog
box.

Browse:

] [

I £ Primexireless Configuration Tool

Folder: C\Program FilesiPrimexWireless\Primex Wireless Configuration T

o]

Cancel

You may choose to make the configuration tool available to just yourself or to anyone who uses your
computer. Choose the Just me option button to only allow the configuration tool to be used when you’re
signed into your computer (recommended); choose the Everyone option button to allow anyone signed into

your computer to use the configuration tool.

When you’ve completed selecting your preferences with
the Select Installation Folder dialog box, click the
Next> button. The wizard displays a Confirm
Installation dialog box similar to the one shown here.
This is the final step before installation begins. Click the
Next> button to proceed with installation; click the
Back button to return to the Select Installation
Folder dialog box or click the Cancel button to end the
installation process without making any changes to your
computer.

When you click the he wizard displays Next> button, the
wizard displays a progress meter that shows the
installer’s progress and when installation is complete, the
wizard displays an Installation Complete dialog box
similar to the one shown here. At this point, the
configuration tool has been installed on your computer;
click the Close button to close the wizard.

Confirm Installation

The installer is ready to install Primex wireless Configuration Toal on your computer.

Click "Mest" to start the: installation.

Cancel |

Installation Complete

Primezx \Wireless Configuration Tool has been successfully installed.

Click "Close" to exit

Please uze Windows Update to check for any critical updates ta the MET Framework.

(Earize]

Cloge

< EBack

Appendix - Install/remove Configuration tool software
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Uninstall Configuration Tool software

Follow these steps to uninstall the
Configuration Tool software: (I er— I showopdstes  Sortbyime ]
8. Choose r (&) PowerDvD See 3127MB
Start » Settings » Control
Panel » Add or Remove n;%
Programs. Windows displays pr
an Add or Rgmove o E"". © Qurten 2005
Programs dialog box similar POl | @ uickrine s 2.3
to the one shown here. Scroll {8 Rapid C55 2007 v6.1 Ses 6.72MB
down the Currently installed LYl |© veorlere
prog rams ||St and select . $af Realtek High Definition Audio Driver Siee =0.27ME
Pri mex WI reless d 5! Recovery Software Suite Gateway Size  5,16MB
Configuration Tool. Click o Rnarone ez S ez
ﬁ! Softy92 Data Fax Modem with SmartCP Size: 0.52MB
the Remove button. B Soric Encoders s a0
ﬁ! Sony Digital Yoice Editar 2 Size: 14,00ME B
;‘@ Sony Ericsson DRM Packager 1.35 Size: 3.69ME
I Spvbat - Search B Destroy Size  32,56MB
[ Spybat - Search B Destroy 1.3 Size  15.47ME T
9. Windows displays an Add or
Remove Programs
confirmation message box \?2 Are you sure wou wank bo remowve Primex Wireless Configuration Tool From your computer?
similar to the one shown here.
Click the Yes button to confirm Yes Mo |
that you want to remove the

Configuration Tool software
from your computer.

Uninstall Configuration Tool software Appendix — Install/remove Configuration tool software
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Index

Index Uninstall Configuration Tool software



Primex Wireless — United States
965 Wells Street
Lake Geneva , Wisconsin 53147

Phone: (800) 537-0464
Fax: (262)248-0061

Email: support@primexwireless.com

Web: http://www.primexwireless.com/
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